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Terms and Notes

CD-ROM (Compact Disc Read-Only
Memory)
A removable, read-only optical disc that can
store relatively (when compared to 3½" floppy
disks) large amounts of data.

CD-ROM drive
A drive that retrieves information from CD-ROMs.

disk drive
A mechanical device used to transfer
information back and forth between the
computer's memory and a disk.

floppy disk
A removable, magnetically coated diskette
on/from which information can be stored and
retrieved.

hard disk
A large-capacity storage area on/from which
information can be quickly stored and retrieved.

hardware
The group of components that makes up the
computer system.  Hardware can be seen and
touched.

keyboard
A device used to enter data and issue
commands to the computer.

memory (RAM)
The workspace area of the computer that
temporarily holds the instructions (software or
programs) and information (data or commands)
you give it.  When you turn the computer off,
everything in RAM disappears.

modem
A device that converts data so that you can
transmit it over telephone lines.  Also called
fax/modem.

monitor
A screen that displays the information in
the computer.

mouse
A small, hand-held device used to control the
pointer on the screen and issue commands to
the computer.

printer
A device that makes a hard copy of data in
the computer.

processor (CPU)
The part of the computer that processes the
instructions in the memory.

read-only memory (ROM)
A computer chip that holds information that
cannot be changed.

speakers
Devices that play sounds which are transmitted
from your computer.

�
The computer system is your assistant.  It has its own:

� brain (processor or central processing unit [CPU])
� workspace (working memory or random-access memory [RAM])
� built-in instructions (read-only memory chips [ROM])
� file cabinets (disk drives)
� storage medium (hard disk and floppy disks)

Your computer comes with:
� monitor (to show you what is going on)
� printer (to make hard copies of documents)
� keyboard (to enter commands and data)
� mouse (to control the pointer on the screen)
� modem or fax/modem (to e-mail, chat, fax, and use the Internet)
� CD-ROM drive (to install large programs, etc.)
� speakers (to play music and sounds)

Other hardware that is becoming common with today's computer systems
includes:

� scanner (to digitize information so the computer can understand it)
� network interface card (to connect to other computers)

Basic Computer System, Hardware
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application software
A set of instructions that your computer follows
to perform one specific task, such as word
processing or creating a graphic.  While the
term application is used a lot in Windows, this
book uses the term program more often.

computer
An electronic device that performs complex
tasks at a high speed and with great accuracy.
There are two main parts of a computerthe
processor and the memory.

disk crash
Damage to a disk drive that: 1) leaves it
inoperable and 2) may cause data loss.

firmware
A kind of system software.  More specifically,
firmware is instructions that are built into the
computer system on ROM chips.

operating system
System software that acts as a link between
you, application software (i.e., programs), and
hardware.

ROM (read-only memory)
A computer chip that holds information that
cannot be changed.

software
Instructions that tell your computer how to
perform a task.  Software is stored on disks
in program files.  (See Topic 14, Files and
Filenames, and Topic 15, Disk Drives and
Folders.) Unlike hardware, software cannot be
seen or touched.  There are two main kinds of
software:  system software and application
software.

system software
Software that runs the computer system.  This
includes firmware and your operating system.

�
The computer can do nothing until it is given instructions—software.
Software is a set of instructions that tells the computer what to do.  There are
two main kinds of software:  

� system software (firmware and an operating system)
� application software (programs)

Software is an essential part of your computer system, and the operating
system is required to make your computer work.  The operating system
looks after the different parts of your computer system, linking them to each
other and to you.

Most software originates on CD-ROMs and floppy disks (except for firmware,
which is built into your computer).  The hard drive on all computers is initially
empty, but most computers come from the factory with an operating system
(usually Windows) and other programs pre-installed on the hard drive.  If you
prefer, however, you can wipe the hard drive clean (format it) and install a
different operating system and/or new programs.

Application software is copied from CD-ROMs and floppy disks onto the hard
disk for convenience and speed.  You then put the original software away for
safe keeping—in case your hard disk crashes and you need to reinstall the
software later.

Basic Computer System, Software
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graphical user interface (GUI)
A phrase that is commonly used to describe
Microsoft Windows 2000 and other operating
systems that use pictures (i.e., graphics) to help
you connect to the computer system’s hardware
and software in an easy-to-understand, intuitive
way.

Microsoft Windows 2000
An operating system that uses a graphics
environment (i.e., graphical user interface) to
connect you to the computer system's hardware
and software in an easy-to-understand, intuitive
way.  Microsoft Windows 2000 also offers many 
built-in, general-use programs.

operating system
System software that acts as a link between
you, application software (i.e., programs), and
hardware.

program 
A set of instructions that your computer
follows to perform one specific task, such as
word processing or creating a graphic. While
the term application is used a lot in Windows,
this book uses the term program more often.

you
The operator (or user) of the computer system
(its hardware and software). 

�
Windows Is an Operating System
An operating system links you to your programs (also called applications or
software) and then links your programs to the computer system's hardware.
The Windows 2000 operating system is called a graphical user interface
(GUI) because it uses pictures to help you communicate with the computer.

Windows 2000 has been designed to provide you with an easy-to-use,
reliable, and fast operating system.  In addition, access to the Internet is built
in, with the Internet Explorer 5.0 browser integrated as a central part of
Windows 2000.

Your Computer System
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e-mail (electronic mail)
A global communication system for exchanging
messages and attached files; this is probably
the most widely used feature on the Internet.
Many Web browsers include an e-mail
program—Internet Explorer uses Outlook
Express for e-mail.

HTML (Hypertext Markup Language)
The programming language used to create Web
pages so that they can be viewed, read, and
accessed by any computer running on any type
of operating system.

Internet
A global collection of computers that
communicate with one another using common
communication protocols (e.g., HTTP).

Internet service provider (ISP)
A company (often local) that provides you with a
connection to the Internet for a fee.

multimedia
The combination of many various
communication methods, including text,
graphics, sound, animation, and video.

multitasking
The ability of an operating system to run more
than one program at a time.

network
Two or more computers that are linked together
to share programs, data, and certain hardware
components (for example, a printer).

newsgroup
A collection of special-interest messages
posted by individuals to a news server on the
Internet.  You need a special program to read
and respond to newsgroups.

object
One of the many things that you use when
working with the computer system—items such
as files, programs, folders, shortcuts, disk
drives, Control Panel tools, My Computer, My
Network Places, and the Recycle Bin.
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Web page
A document created using HTML that can be
posted on the World Wide Web.

window
A rectangle that holds a dialog box, folder,
program, or document.

�
What Does Windows 2000 Do?
Microsoft Windows 2000 does the following:

� Provides an easy way to start programs.
(the Start button does this)

� Runs more than one program at a time.
(called multitasking)

� Provides an easy way to switch between open programs.
(the taskbar does this)

� Lets you open more than one program at a time.
(it uses windows to do this)

� Makes it easy to work with files, folders, and other objects.
(Windows Explorer does this)

� Transfers information between programs.
(called Object Linking and Embedding [OLE])

� Provides a "Web-page" desktop and folder environment.
(you can change the environment back to the classic Windows 95 style 
if you wish, however)

� Provides access to the Internet.
(Internet Explorer does this)

� Provides access to e-mail and newsgroups.
(Outlook Express does this)

� Lets you talk with others using live video and a shared whiteboard. 
(Microsoft NetMeeting does this)

� Provides networking support.
(Network Neighborhood provides easy network access)

� Provides multimedia programs.
(use CD Player to play compact discs; Media Player to run multimedia
files; and Sound Recorder to record, edit, and play recorded sounds)

� Provides other general-use programs.
(called accessories; for example, WordPad, Paint, Calculator, 
and games)

� Provides security.
(lets you secure your computer; create new groups; set up files, folders,
and printer permissions; encrypt files and folders; audit objects and
events; and manage group policy)

� Provides easy-to-use faxing.
(Fax Service Management does this)

� Provides tools for maintenance.
(called System Tools; for example, Backup, Disk Cleanup, Disk
Defragmenter, and Scheduled Tasks)

� Provides tools for personalizing your workspace.
(located in the Control Panel)

������	�������	���������	� � TOPIC 4
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button
A graphic element found in dialog boxes, on
toolbars, and in certain other places that, when
activated, performs a specific function.  
A command button in a dialog box is a
rectangular button with the name of its function
on it, such as OK, Yes, No, Cancel, Save,
Open, etc. 
A toolbar button is a square button with an icon
that illustrates its functionyou can usually
display or hide text labels under toolbar buttons.  
Buttons also appear on a window title bar and
on the taskbar.  When you point to buttons
(other than command buttons), a ToolTip
appears that names, or describes the action of,
the button.

desktop
The opening screen in Windows 2000 that
contains a few objects, the Start button, and
the taskbar.  The button shown above is the
icon used to represent the desktop throughout
Windows 2000.

icon
A small picture that represents one of the many
objects that you use when working with the
computer system.

object
One of the many things that you use when
working with the computer system—items such
as files, programs, folders, shortcuts, disk
drives, Control Panel tools, My Computer, My
Network Places, and the Recycle Bin.

Start button
The button located at the left end of the taskbar
that is labeled Start.  Click the Start button to
open the Start menu, from which you can open
other menus and launch programs.

taskbar
The bar that appears by default on the bottom
of the desktop and lets you quickly start
programs and switch between tasks.

�
The Windows Desktop
The redesigned Windows 2000 desktop is clean and straightforward.
However, there is still the same obvious starting pointthe Start button.

Windows 2000 Web-Style Desktop

Windows 2000 Desktop with Pop-Up Menus Displayed

TOPIC 5 � ������� �	�
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Address bar
A drop-down text box that lets you access a
Web page or a location on your computer by
typing or selecting an address or path.

Close button
A button located at the right end of a title bar
that you click to close a window.

Control menu
A menu with items that you use to manipulate a
program window (Restore, Move, Size,
Minimize, Maximize, and Close).  It is opened
by clicking the Control menu button or by right-
clicking the desired program’s taskbar button.

Control menu icon
An icon at the left side of the title bar that opens
the Control menu.  The icon for the Control
menu button matches the program’s file type
icon.  (For folder windows, the icon is a folder.)

Internet icon
A picture of the Microsoft flag that appears on
the right end of Windows 2000 menu bars; it
rotates, displaying the Earth on the other side,
when a new Internet Web page is accessed.

Links toolbar
The toolbar that provides hyperlink to commonly
used Web sites.

Maximize button
The button in the middle of the three buttons
located at the right end of the title bar on a
restored window.  This button enlarges a
window to its greatest possible size.  When you
maximize a window, the Maximize button is
replaced by the Restore button.

menu bar
The bar located under the title bar that lists the
available menu items for the open document or
folder.

Minimize button
The button located on the right side of the menu
bar and/or title bar that you can click to reduce
a window to a taskbar button.

�
Window Elements
Most window elements activate commands.
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Restore button
The button in the middle of the three buttons located
at the right end of the menu bar and/or title bar on a
maximized window.  This button returns a
maximized window to its previous size.  When you
restore a maximized window, the Restore button is
replaced by the Maximize button.

sizing handle 
An area in the bottom-right corner of windows that
can be sized.

Standard toolbar
A row of buttons that provide quick access to
frequently used commands.

status bar
The bar at the bottom of a program or folder
window.  It displays information about the program
or folder, and it can be turned on and off from the
View menu.

title bar
The horizontal bar at the top of a window that
provides the name of the open document and/or
program.

Web View
A folder window feature in which descriptive and
hyperlink text appears on the left side of the folder
window’s work area.

window
A rectangle that holds a dialog box, folder, program,
or document.

window border
The boundary that marks the edges of a window
and can be used to size that window.

window title
The name of a window, located just to the right of
the Control menu button.  The document name, if
any, is listed along with the program name.

work area
The inner part of a window where the work in a
document or program is carried out.

Control menu button
Click to open the Control menu.
Double-click to close the window.
The Control menu button icon is a
copy of the file type icon.

Control menu

Window title Menu bar Title bar

Minimize button
Click to reduce a
window from the
desktop, but not
close it.

Restore button
Click the Restore button to return 
a window to its original size.
When a window is maximized, 
the Restore button replaces the
Maximize button.

Maximize button
Click to enlarge a window
to its maximum size.

Close button
Click to close a window.

Internet icon

Standard toolbar

Address bar

Go button

Window border

Sizing handleWork areaStatus barWeb view area
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accessories
Supplemental, built-in programs that come with
Windows 2000.
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�
Windows Accessories
In addition to being an operating system, Windows 2000 offers many kinds of
built-in programs called accessories.  There are programs for:

� games
� general use
� entertainment

Each Windows program has an icon to help you identify it quickly.  Many
accessory icons are shown below.

Games

FreeCell

Minesweeper

Pinball

Solitaire

General Use

Address Book to store contact information.

Calculator to make calculations.

Imaging to perform basic tasks with faxes and scanned pictures.

Notepad to write and view simple text documents.

Paint to create pictures.

Windows Explorer to manage folders and files.

WordPad to write and format documents.

Entertainment

CD Player to play compact discs.

Sound Recorder to record, edit, and play sound files.

Volume Control to adjust the sound level.
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Alphabetical list of programs that
ship with Windows 2000
Professional

� Address Book
� Backup
� Calculator
� CD Player
� Certificates
� Character Map
� ClipBook Viewer
� Computer Management
� Device Manager
� Disk Cleanup
� Disk Defragmenter
� Disk Management
� Dr. Watson
� DVD Player
� Event Viewer
� Fax Service Management
� FreeCell
� Group Policy
� HyperTerminal
� Imaging
� Indexing Service
� Internet Explorer
� IP Security Policy Management
� Local Users and Groups
� Magnifier
� Minesweeper
� Narrator
� NetMeeting
� Notepad
� On-Screen Keyboard
� Outlook Express
� Paint
� Performance
� Phone Dialer
� Pinball
� Private Character Editor
� Registry Editor
� Removable Storage Management
� Security Configuration and Analysis
� Security Templates
� Services
� Shared Folders
� Solitaire
� Sound Recorder
� Synchronization Manager
� System Information
� Telnet
� Windows Media Player
� Windows Task Manager
� Windows Update
� WordPad

��������������
��
�#���	���
�����

� Click the Start button, then click Help.
� Click the Index tab.
� Type Windows 2000 in the text box.
� Click Programs included with.
� Click the Display button.
� Click the desired program.

Media Player to play multimedia files.

DVD Player to play digital video discs.

Communications
HyperTerminal to connect to a communications item using your 
modem or a null modem cable.

NetMeeting to participate in meetings over the Internet or an intranet
using voice, video, program sharing, and data conferencing.

Network and Dial-up Connections to create a new connection or 
open a pre-existing connection.

Phone Dialer to place and accept calls from your computer.

System Tools

Backup to create a copy of the data on your hard disk.

Character Map to copy and paste special characters into your 
documents.

Disk Cleanup to free up space on your hard drive.

Disk Defragmenter to rearrange files, programs, and unused 
space on your hard drive disk.

Getting Started to introduce you to Windows 2000.

Scheduled Tasks to schedule computer maintenance jobs to run at 
a convenient time.

Accessibility

Accessibility Wizard to configure your system to meet special 
needs.

Magnifier to enlarge selected text and other items for easier viewing.

Narrator to read on-screen text, dialog boxes, menus, and buttons 
out loud.

On-Screen Keyboard to display a keyboard that is controlled by a 
mouse or switch.

Utility Manager to start and configure accessibility tools from one place.
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commands
Instructions that you issue, causing an action to
be carried out.

control keys
Certain keys (Shift, Ctrl, and Alt) that are used
in combination with other keys to issue
commands.  Also called modifier keys.

keyboard
The device used to enter data and issue
commands to the computer.

keyboard shortcuts
Key combinations that are used to activate
certain commands as an alternative to using
the mouse.

mouse
A small, hand-held device used to control the
pointer on the screen and issue commands to
the computer.

pointer
The arrow-shaped cursor on the screen that
moves with the mouse as you slide it over a flat
surface.  The pointer's shape changes
depending on the job it is doing (or can do) at
the current time.  Also called arrow pointer or
mouse pointer.

Common Pointer Shapes

SHAPE NAME

arrow
the standard shape

background
system is working in the 
background

help
describes selected item

busy
signals for you to wait

unavailable
cannot perform action

link select 
selects hyperlinks

text select
selects text

move
moves windows

sizing
sizes windows

�
Controlling Windows
You can control Windows using commands, which are instructions that cause
an action to be carried out.

The Windows graphics environment is designed to take advantage of the
mouse as a method of issuing commands, though commands can often be
issued from the keyboard also.  (There are usually several different ways to
issue commands.)  While the large variety of command choices can lead to
confusion for beginners, it offers enough flexibility to meet the requirements of
many different Windows users.

The Mouse

The mouse is a small, hand-held device that is used to control the pointer on
the screen.  The pointer is the arrow on the screen that moves with the mouse
as you slide it over a flat surface.  The pointer shape changes depending on the
job it is doing (or can do) at the current time.

A mouse usually has at least two buttons: the primary mouse button (usually
the left button) and the secondary mouse button (usually the right button).

There are six main mouse actions:
Point Move the mouse until the tip of the mouse pointer is over 

the item you want.
Click Press and quickly release the left mouse button.
Right-click Press and quickly release the right mouse button.
Double-click Press and quickly release the left mouse button twice.
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Drag Point to an item, then
hold down the left mouse button,
slide the pointer to a new location, and
release the mouse button.

Right-drag Point to an item, then
hold down the right mouse button,
slide the pointer to a new location, and
release the mouse button.
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The Keyboard

The keyboard is used to enter data and to issue commands to the computer.

The twelve keys located across the top of the keyboard that are labeled F1
through F12 are called function keys.

Control keys (Shift, Ctrl, and Alt) are used in combination with other keys to
issue commands.

Keyboard shortcuts are key combinations that can be used to activate
certain commands as an alternative to using the mouse.  A menu command
that has a keyboard shortcut available will display its key combination to the
right of its command name.

Using Keys Together

When two keys are used together to issue a command, a plus sign (+) is
shown between the keys.  For example: � + �.

To issue this command, you should press and hold down �, tap �, and
then release �.

Using Keys in Succession

Keys are used in succession when two or more keys are pressed one after
the other to issue a command.  Keys used in succession are illustrated with
a comma separating them.  For example: �, �, �.  Press each key in
succession.

Four Special Keys

� (the Escape key) is used to back out of situations.  Occasionally you find
yourself in a place you don't want to be; the Escape key will often get you out
of these situations without doing any damage to your work or the computer.

� is used to get Help.

(the Windows key) Some keyboards have this key, which is used to open
the Start menu quickly.

(the Application key) Some keyboards have this key, which is used to
open shortcut menus for the active object quickly.

Escape key Function keys Indicator lights

Control keys Cursor
control keys

Numeric keypad/
cursor control keys

SpacebarControl keys

Windows key
Application key

Windows key

Terms and Notes

Keyboard Shortcuts
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COMMAND SHORTCUT

New..................................................� + 	

Open ................................................� + 


Save ................................................� + �

Print ................................................� + �

Undo ................................................� + 


Cut ..................................................� + �

Copy ................................................� + �

Paste ..............................................� + �
Clear ..........................................................�

Select All ........................................� + �

Find ................................................� + �

Replace ..........................................� + �

Bold ................................................� + �

Italic ................................................� + �

Underline ........................................� + �

Left Justify......................................� + �

Center Justify ................................� + �

Right Justify ..................................� + �

Switch to ............� + � OR� + �

Start menu ....................� + � OR

Start button ........................� + �, �

Taskbar ..............................� + �, �,

�, �

Control Menu ..................................� + �
(document window)

Control Menu ..........................� + �
(program and 
folder windows)

�
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common dialog boxes
Dialog boxes, such as Open, Save As, and
Print, which are basically the same in many
different programs.  Common dialog boxes
make it easier for you to learn new programs.

controls
The elements in a dialog box that ask for
information from the user in order for the dialog
box to complete its task.  Such elements include:

dialog box
A special kind of window that offers different
controls for you to manipulate in order to
change the performance or appearance of a
document or program.

tabs
In connection with dialog boxes, tabs refer to
the “flaps” at the top of a series of separate
groups of settings (sometimes called pages)
that appear in some dialog boxes, particularly in
Properties dialog boxes.

window
A rectangle that holds a dialog box, folder,
program, or document.
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� check boxes
� command buttons
� drop-down list box
� list box
� option buttons

� slider
� spin box
� tabs
� text box

What Are Dialog Boxes?
Dialog boxes are windows that contain one or more different kinds of
controls that you can use to: 

� Change the performance of a program (such as how often a file is saved).
� Change the appearance of a document (such as changing the font).

There are many different kinds of windows in Windows 2000, and that can be
confusing to new users.  For example, there are program windows, folder
windows, and dialog box windows.  You can quickly tell if a window is a dialog
box, however, because, while it has a Help button and a Close button in the
top-right corner, it does not have a Maximize or Minimize button.

Some dialog boxes are very similar from one program to another.  These
common dialog boxes, such as Open, Save As, and Print, make it easier to
learn new programs.

You can make as many changes as you wish in a dialog box, then you usually
click the OK button to close the dialog box and activate the new settings.  
In the dialog box below, however, you would click the Open button to activate
the new settings.

The Open Dialog Box

Tabbed Dialog Boxes
Some dialog boxes use tabs to organize the many settings that are available
to you.  Each tab is always visible, making it easy for you to keep track of
where you are.  To switch between them, simply click the tab you want.

Dialog Box Controls
Command buttons Carry out an action, such as:

OR

Text box A box that provides space for typing any information
needed to carry out a command.
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Drop-down list box

Text box

Drop-down list box

Command buttons

Tabs
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Check boxes Square boxes next to the items in a list from which
you may select as many options as desired.  Selected
check boxes contain check marks.

Option buttons The circles next to the items in a list from which you
may select only one option.  A selected option button
contains a dot in its circle.

List box A box that displays a list of options from which you
can choose only one.  Scroll to view additional
options.

Drop-down list box Similar to a list box, except that a drop-down list box
must be opened by clicking it or its arrow.  Drop-down
list boxes are usually found in small or crowded 
dialog boxes.

Spin box A text box containing a preset value that can be
adjusted incrementally by clicking its up or down
arrow as desired.  (A new value can also be typed in.)

Slider Lets you set a value within a specified range.

Selected

Deselected

Selected
Deselected

Closed

Opened
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Terms and Notes

file
Data or program instructions that are saved on
a disk as a named unit.

filename
The name you give to data that is stored on
a disk.

filename extension
The period and, usually but not always, three
characters at the end of a filename (for example,
.rtf, .doc, .txt, .gif).  Also called file extension.

file type
The kind of file that is created by a particular
program.  Files are defined by the programs
they are created in.  Every file type has an icon
associated with it; occasionally, a file type has
more than one icon associated with it.

program 
A set of instructions that your computer follows
to perform one specific task, such as word
processing.  Also called application.
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What Are File Types?
In this lesson, you will be creating, saving, printing, and opening documents.
Saving a document creates a file on a disk.  The kind of program you use to
create the file determines what is known as the document’s file type.

When you save a document, you give it a filename; the program you are
using automatically assigns the document a filename extension and an icon.
The filename extension and the icon identify the document's file type and thus
associate the document with the program in which it was created (in most
cases).  Some file types, however, can be opened in more than one program.
Further, some programs can open more than one file type.  Windows 2000
recognizes file types by their filename extensions (which are usually hidden to
you), but you can identify file types by their icons.

When you save a file in Notepad, it adds the filename extention .txt (Text
Documents).  When you save a file in WordPad, it adds the filename
extension .rtf (Rich Text Format).  Because both WordPad and Microsoft Word
use .rtf as a file type, there can be some confusion with the .rtf file type icon.
If you have Microsoft Word on your computer, WordPad will use the Microsoft
Word icon rather than the WordPad icon when you save a document in
WordPad.  Notepad and WordPad file type icons are illustrated below.

Notepad icon for .txt file types

WordPad icon for .rtf file types if you do not have Microsoft Word

WordPad icon for .rtf file types if you do have Microsoft Word

In Exercise 18, you will first start a program (Notepad or WordPad) and then
use the Open dialog box to open a document.  In later exercises, you will
open files without starting the program first; when you do, Windows 2000 will
automatically start the correct program based on the strongest association of
the document's file type.

The work area in the Open dialog box displays only those files that match the
file type shown in the Files of type drop-down list box—even though there may
be files of other types in that folder.  If you want to open a document with a
different file type, you must first change the Files of type drop-down list box to
the file type you want to open.  Therefore, if you want to open a text file in
WordPad, you must first change the Files of type drop-down list box setting to
Text Documents (*.txt) since WordPad's default is to use the Rich Text Format
(.rtf) or Word for Windows (*.doc) file type.

Notepad's Open Dialog Box

TOPIC 10 � %�	#��
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Files of type 
drop-down list box

Text Documents
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Terms and Notes

bar
The term bar is used to define window stripes
(e.g., the title bar, menu bar, and status bar).  In
addition, bar is also used to define certain
special Windows 2000 features (e.g., the
Explorer bar, Channel bar, and Address bar).

status area
The area at the right end of the taskbar that
displays system icons and offers easy access to
(and information about) those system features.
Some icons appear in the status area
temporarily; for example, the printer icon
appears only when you print.

taskbar
The bar that appears by default at the bottom of
the desktop and lets you quickly start programs,
switch between tasks, and access the tools
(and toolbars) of your choice.

taskbar button
A button located on the taskbar that represents
an open program.  Each taskbar button displays
the program icon and name of each open
program.
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�
What Is the Taskbar?
By default, the taskbar is the bar at the bottom of the desktop with the
following items:

� Start button on the left end
� Quick Launch toolbar (which can be removed)
� Taskbar button area
� Status area at the right end

The taskbar is easily customized, so yours may look different from the
illustration of the default taskbar below.

Taskbar without Taskbar Buttons

Taskbar with Taskbar Buttons

What Does the Taskbar Do?

Use the taskbar to:
� Switch between open programs
� Arrange windows
� Control programs
� Access the Web
� Access the desktop
� Change the system date and time

You can customize the taskbar by:
� Putting toolbars (and bars) on the taskbar, including: Quick Launch,

Address, Links, and Desktop
� Creating your own new toolbar
� Hiding toolbar button names (text labels)
� Hiding the taskbar
� Moving the taskbar
� Sizing the taskbar

The Start Button
The taskbar's Start button lets you carry out many basic Windows 2000 tasks:

* Not on the Start menu by default.

� View a list of Programs
� Start Programs
� Open your Favorites folder*
� Open Documents
� Change computer Settings

� Search for Files or Folders
� Get Help
� Use the Run command
� Log Off Windows*
� Shut Down the computer

������� '�� � TOPIC 11

Start button Quick Launch toolbar Taskbar button area Status area

Taskbar buttons
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Classic style
The Windows 95 and NT4 approach to working
with folders, icons, and the desktop.  It includes: 

� browsing windows using separate
windows

� click-to-select/double-click-to-open
browsing

� icon titles that are not underlined
See also Web style, below.

folder
A structure that holds files and/or subfolders
that are stored on a disk.  A folder can also
contain other objects, such as printers and
disk drives.  (Folders have traditionally been
called directories.)

Folder Options
The command that offers a choice of two
options in each of the following categories:

� Active Desktop
� Web View
� Browse Folders
� Click items as follows

The first option is referred to as Web style; the
second, as Classic style.

folder window
A window that displays the contents of a folder
(or certain other objects, such as disk drives).
Folder windows offer many of the same folder-
managing features as Windows Explorer.  Click
a folder (if Web-style browsing is enabled) to
open its window and see what is in it.

Internet icon
A picture of the Microsoft flag that appears on
the right end of Windows 2000 menu bars; it
rotates, displaying the Earth on the other side,
when a new Internet Web page is accessed.

Web style
The Web-page approach to working with
folders, icons, and the desktop.  It includes:

� browsing windows using the same
window

� point-to-select/click-to-open browsing
� underlined icon titles
� enabling Web-related content in folders

and on the desktop
See also Classic style, above.

�
Windows 2000 Folder Windows
Folder windows display the contents of folders.  Folder windows have
several standard Windows elements: 

� Minimize, Maximize, and Close buttons
� Menu bar
� Toolbar
� Status bar
� Control menu button

The following new elements have been added to Windows 2000 folder
windows to make it easier for you to access the Internet, change folder
appearance, and get information from within a folder window:

Folder Options
In addition to adding new elements, Windows 2000 lets you change certain
folder options.  The Folder Options dialog box can be opened from folder
windows (click Tools, then Folder Options) or the Control Panel (click the Start
button, Settings, Control Panel, then double-click the Folder Options icon).  In
the Folder Options dialog box on the next page, the Web options are the top
options in each section while the Windows classic options are the bottom
options in each section.

� Internet icon
� Address toolbar
� Links toolbar*
� Radio toolbar*
� Go button
� Favorites menu
� Tools menu

� Back, Forward, and Up buttons
� Search, Folders, and 

History buttons
� Explorer bars*
� Web content
� Customize this folder*
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Back, Forward,
and Up buttons

Favorites menu Tools menu
Search, Folders,
and History buttons

Internet icon

Address
toolbar and
Go button

Web view area
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Active Desktop
The Windows 2000 desktop that consists of two
layers: one layer on which you can display
standard desktop objects, and a second layer
on which you can display HTML objects.

Web View
A folder window feature in which descriptive
and hyperlink text appears on the left side of
the folder window’s work area.

�
Folder Options dialog box with default options selected

Windows 95 and NT4 did not offer the folder options that Windows 2000 and
Windows 98 have. The new design offers flexibility to users. Windows 2000
has set the default options to please most people. Some of the default options
are set for Web style and other defaults are set for classic style. Still, some
users familiar with Windows 95 may prefer using more classic folder options.

In this book, you will usually be instructed to use the default folder options
shown in the Folder Options dialog box illustration above.  The most visible
folder option category is Click items as follows.  The default choice for this
category is Double-click to open an item (single-click to select).  If you feel
comfortable using Single-click to open an item (point to select) instead, you
may change to that option for Exercise 28 and beyond.  Always keep in mind,
however, that the directions are usually written for the Double-click to open an
item (single-click to select) option.

Table of Folder Options

Default options are shaded:

OPTION WEB STYLE WINDOWS CLASSIC STYLE

Active Desktop Enable Web content on my desktop Use Windows classic desktop

Web View Enable Web content in folders Use Windows classic folders

Browse Folders Open each folder in the same window Open each folder in its own window

Click items as follows Single-click to open an item Double-click to open an item 
(point to select) (single-click to select)

Restore Defaults button

Click items as follows

Browse Folders

Web View

Active Desktop
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special folder
A folder designed to hold specific items; for
example, My Computer,  Local Drive (C:), and
My Documents.

�
Special Folders
Folders are used to organize your files and other folders (see Topic 15, Disk
Drives and Folders).  Most folders are represented by a folder icon.  Some
special folders are represented by a folder with a picture on it; and some
objects that act as special folders do not have a folder icon at all.  Below are
illustrations of some special folder icons and a description of each folder’s
function.

Desktopthe logical top-level folder, in contrast to drive C:,
which is the actual top-level folder (see Topic 16, Windows 2000
Structure).  It holds My Computer, My Documents, and other
folders and shortcuts.

My Computerthe quick route to the disk drives, folders, files,
and other objects on your computer system.

Local Disk (C:)the top-level (or root) folder on your computer.
Local Drive C: usually holds all the other folders in the computer,
including the Desktop folder.

3½ Floppy (A:)the floppy disk drive folder.  Floppy drive A: holds
the data files stored on the removable floppy disk currently
inserted.

Compact Discthe CD-ROM disc drive. Reads data, such as
programs, music, etc., on a removable CD-ROM disc.

Printersadds a new printer setup or changes settings for an
existing printer.

Control Panelpersonalizes your computer by letting you
change various settings, such as your screen display, system
date/time, mouse settings, passwords, etc.

Network and Dial-Up Connectionsprovides a link between
your computer and the Internet, a network, or another computer.

Scheduled Taskscontains tasks that you tell the computer to
run when it's easiest for you; for example, you may schedule a
job like defragmenting the hard drive to take place in the middle
of the night.

My Documentsprovides you with a handy place to store
documents.  Windows 2000 accessory programs such as
WordPad automatically store documents in the My Documents
folder, but you can change the storage location.

My Picturesprovides a handy place to store your graphics
files. Windows 2000 accessory programs such as Paint
automatically store documents in the My Pictures folder, but you
can change that storage location.

Favoritesholds frequently used Web-page addresses and
paths so you can easily access Web sites and items on your
computer.  You can further organize your favorites into 
subfolders of the Favorites folder.

TOPIC 13 � ���
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Group foldersfolders that are found primarily within the
Programs folder that hold groups of program shortcuts.  They
represent menu items that appear in the Programs submenu of
the Start menu.

Historylists Web sites and computer locations that you have
recently visited.

Today (or other time period)organizes your history (list) of
visited Web sites by placing those sites into folders that are labeled
with the days of the week on which the sites were visited.

Downloaded Program Filesthe default location where
Windows 2000 stores downloaded Active X and Internet-related
programs.

Offline Web Pagesstores Web pages so you can view them
when you are not connected to the Internet.

My Network Placesthe entry point to other computers on your
network. If you are not on a network, this folder icon may not
appear on your desktop.

Recycle Binholds “deleted” documents in case you change
your mind and want to restore them.  Once you empty the
Recycle Bin, however, you can no longer restore these
documents.
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associated file
A file that has been identified as belonging to a
certain program, such as .txt with Notepad,
.bmp with Paint, or .doc with Microsoft Word.
When you open an associated file, the program
related to that file also opens automatically.

document
A file that consists of data created in a program,
such as a letter typed in WordPad or a picture
drawn in Paint.  Also called data file.

file
Data or program instructions that are saved on
a disk as a named unit.

filename
The name you give to data that is stored on a disk.

filename extension
The period and, usually but not always, three
characters at the end of a filename (for
example, .doc, .txt, .gif).

file types
Files are defined by the programs that they are
created in.  Every file type has an icon associated
with it.  Below are examples of file types and their
icons:

Application (.exe)

Bitmap image (.bmp)

Font File (.fon)

generic icon 

Help File (.hlp)

Microsoft HTML Document 
5.0 (.htm)

Microsoft Word Document (.doc)

MIDI Sequence (.mid)

Rich Text Document (.rtf)

Text Document (.txt)

OpenType Font (.ttf)

long filename
A filename that is up to 255 characters long and
can contain spaces and most symbols.

program file
A file containing a set of instructions that your
computer follows to perform a specific task, such
as word processing.

short filename
A filename that is no longer than eight characters,
can contain a filename extension, but cannot
contain spaces or certain symbols.

�
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Files
A file is a collection of data that is given a filename and stored on a disk.
Some of the file-managing jobs that Windows 2000 helps you perform are:

Files are identified and categorized in various ways.  Most files you work with
are either

� program files (instructions that perform a task), or 
� data files (information created in a program, such as a letter).

Conventional File-Naming Rules
Before Windows 95, files were named using these rules:

� A filename can be no longer than eight characters.
� You cannot use these characters:  . " / \ [ ] : * | < > + = ; , ?
� You cannot use a space.
� You can use an optional filename extension of a period (.) and up to

three characters.

Long Filenames
You are not confined to the conventional file-naming rules when naming files
created with Windows 2000 programs.  Below are rules for long filenames:

� A filename can contain up to 255 characters.
� You cannot use these characters:  . " / \ < > ? * : |
� You can use a space.
� You can use an optional filename extension of a period (.) and up to

three characters.

When you save a file with a long filename, Windows 2000 not only saves the
long filename you specify, but creates a shorter version of that name which
meets the conventional file-naming rules listed above.  Any programs you may
have that cannot read long filenames will access these files using their shorter
filenames.

Filename Extensions
Filename extensions are usually used to identify groups of related file types.
Certain standard extensions have special meanings:

.exe (execution) program files

.sys (system) files that work with your hardware

.txt (text) text files

.bmp (bitmap) associated with Paint

.doc (document) associated with Microsoft Word or WordPad

Windows 2000 hides filename extensions by default, but you can still identify
file types by their icons (see the side panel).

Where Are Files Stored?
All files are stored on disk in folders. (See the 
next page for more information about folders.)

� organize
� create shortcuts

� name
� rename
� save
� resave

� open
� print
� copy
� move

� paste
� delete
� view
� browse

Files

Folder
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CD-ROM drive
A drive that retrieves information from
removable, read-only optical discs that can
store relatively large amounts of data when
compared to regular floppy disks.

disk
Media on which information is stored and
retrieved in named units called files.

disk drive
A mechanical device used to transfer
information back and forth between the
computer's memory and a disk.

floppy disk
A removable, magnetically coated diskette
on/from which information can be stored and
retrieved.

floppy disk drive
A hardware component of your computer
system.  A drive used to transfer information
back and forth between the RAM and a floppy
disk.

folder
A structure that holds files and/or other folders
(subfolders) that are stored on a disk.  A folder
can also contain other objects, such as printers
and disk drives.  (Folders have traditionally
been called directories.)

group folder
A folder within the Start Menu folder that holds
groups of program shortcuts and other folders;
they each represent menus within the Start menu.

hard disk drive
A built-in storage device that has a
nonremovable disk (a fixed disk) with a large
capacity.

hierarchy
A system of things (or people) ranked one
above the other.  With regard to computers, the
term hierarchy describes the multilevel structure
of folders and subfolders on a disk.  In the case
of Windows 2000, it further describes the
multilevel structure of objects on the entire
computer system.  This structure is also referred
to as a tree.

subfolder
A folder contained within another folder.

�
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Disk Drives
Disk drives are used to store files.  Your computer system comes with at
least two disk drives: one floppy disk drive, named drive A:; and one hard
disk drive, typically named drive C:.  You may also have a second floppy disk
drive, usually named drive B:.  Today, computers also have a CD-ROM drive,
frequently named drive D:.  CD-ROMs can hold much more information than a
floppy disk.  However, most CD-ROMs cannot store your files; they are only
used to read very large amounts of data stored on them.

Many of today's computer systems come with a Zip or Jazz disk drive.  These
drives use disks that can hold much more data than a floppy disk.  This extra
capacity is needed for the very large files created by many of today's high-tech
programs. These drives are especially useful for making backups and
transporting files.

Folders
Folders are created on disks (especially the hard disk) to efficiently organize
the many files that are stored on disks.  Folders may also hold other folders
(sometimes referred to as subfolders) which, in turn, may hold still more files
and folders.  The resulting multilevel structure forms a hierarchy, that is, a
system of folders ranked one above the other.  In Windows 2000, folders are

marked with a folder icon .  Windows 2000 uses the term folder to
describe what used to be called directories. (See also Topic 23, A Look
at Structure.)

The illustration below shows a simplified structure of folders on drive C:.
Notice that all the folders below the Start Menu folder are group folders.
Group folders represent submenus that primarily branch off the
Programs menu.

Structure of Folders on the Hard Disk

Hard disk

First-level folders
on Local Disk (C:)

Folders in the
Documents and
Settings folder

Folders in the
All Users folder

Folder in the Start Menu folder

Folders in the
Accessories folder

Folders in the
Programs folder

Group 
folders
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browse
To look at files, folders, disks, printers,
programs, documents, and other objects on
your computer system.

desktop
The opening screen in Windows 2000 that
contains a few objects, the Start button, and the
taskbar.  The button shown above is the icon
used to represent the desktop throughout
Windows 2000.

My Computer
A special folder (with an icon that appears on
the desktop by default) that gives you a quick
route to the disk drives, folders, files, and other
objects on your computer system.

My Network Places 
The folder used to find shared resources on the
network to which your computer is connected.

Display Hidden Files and Folders

1. Open Windows Explorer.
2. Click the Tools menu.
3. Click Folder Options.
4. Click the View tab.
5. Click the Show hidden files and folders

option button.
6. Click the OK button.

(For more information, see Exercise 76, Display
Hidden Files and Folders.)

�
Windows 2000 Structure Consists of More Than Disks 
and Folders
Microsoft has designed Windows 2000 with networking capabilities (using My
Network Places).  If you are connected to a network, you will be able to
access folders and files on computers other than your own.

The desktop is the heart of Windows 2000.  The illustration below shows the
desktop at the top of the Windows structure.  From the desktop, you can choose
to look at folders and files in My Documents, My Computer, or My Network
Places.

The desktop is the logical—but not physical—top of the Windows 2000
structure; it acts like the top of the structure, but the Desktop folder is actually
a hidden folder located on Local Disk (C:).  While this fact is of little concern to
most users, it may reduce confusion for others.

In the illustration below, dashed lines around the Local Disk (C:) structure
distinguish it from the Windows logical structure above the hard disk.  The
heavy lines show the route from the desktop to the Start Menu folder.  The
Start Menu folder represents the Start menu on your desktop.  The group
folders below the Start Menu folder represent cascading menus that branch off
the Start menu.  Keep this structure in mind when you are browsing folders.

Windows 2000 Structure
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Windows 2000 logical structure
(the part outside the dashed lines)

Local Disk (C:)
structure (same as
on previous page)
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folder window
A window that displays the contents of a folder
(or certain other objects, such as disk drives).
Folder windows offer many of the same folder-
managing features as Windows Explorer.  Open
a folder to turn it into a window and see what is
in it.

My Computer
A special folder (with an icon that appears on
the desktop by default) that gives you a quick
route to the disk drives, folders, files, and other
objects on your computer system.

�
The My Computer Folder Window
From My Computer, you can work your way to any resource on your
computer.  My Computer is a special folder (see Topic 13, Special Folders)
whose icon is on your desktop by default.  My Computer is at the top of your
local computer structure.  Every object in My Computer opens a folder
window that displays the object’s contents.

In Windows 2000, folder windows are essentially the same as Windows
Explorer (the file-managing program covered in Lesson Eight). Simply click the
Folders button to convert a folder window to Windows Explorer, and click the
Folders button in Windows Explorer to convert it to a folder window. Some
features common to both folder windows and Windows Explorer were covered
in Lesson Four, including:

Folder window features covered in this lesson include:

My Computer Folder Window

� Change disk drives
� Change a folder to Windows

Explorer
� Start a program
� Open a document

� Print from a folder
� Create and delete folders
� Move files into a folder
� Favorites

� Select and open objects
� Back, Forward, and Up buttons
� Menu bars and shortcut menus

� Toolbars
� Explorer bars
� Icon views and arrangements
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My Computer icon
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desktop
The opening screen in Windows 2000 that
contains a few objects, the Start button, and the
taskbar.  The button shown above is the icon
used to represent the desktop throughout
Windows 2000.

user profile
Settings that record the changes made to a
user’s environment (such as program items,
screen colors, network and printer connections,
mouse settings, and window size and position)
that are kept separate from other users’
settings. Each time the user logs on to Windows
2000, those familiar settings are loaded.

�
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The Desktop Is the Heart of Windows 2000
The Windows 2000 desktop is more than:

� the large workspace you see when you start Windows,
� the hierarchical structure managed by the shell, or
� the background upon which a few graphic objects and the taskbar appear.

The desktop is the heart of Windows 2000.  The idea behind the Windows
2000 desktop is that you can use it pretty much the way you use your personal
desktop at home—to keep important items at your fingertips.  Just as you put
your computer, printer, clock, phone, folders, and documents on your real
desktop, you can do the same with your Windows 2000 desktop.  Furthermore,
you can decorate it to fit your mood; you can even put your favorite digital
picture on the desktop.

While the computer system is structured with many levels (a hierarchy),
by using shortcuts on the desktop, that structure seems to disappear.  You
can design a logical structure (grouping of files and folders) to meet your
individual needs.

A Traditional Desktop

The Windows 2000 Desktop

Recycle bin

Printer

Computer

Document

Folders

Phone

Calculator

Clock

Internet E-mail
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jump arrow
A small arrow that appears on the lower-left
corner of shortcut icons, thereby distinguishing
them from other icons.

path
The route to an object; it consists of the disk
drive, folder, subfolders (if any), and the
filename (if the path is to a file).

Properties dialog box
A special kind of dialog box that groups the
settings for a specific object's properties.

shortcut
An icon containing a direct route to a specific
object and displaying a small jump arrow on its
lower-left corner.   Click the shortcut icon to
quickly open the file or program it represents.
You can customize your desktop by creating
shortcuts to the documents and programs you
use most often.

target
The path (including the name) to the object to
which a shortcut is pointing.

�
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��� � TOPIC 19
Shortcuts Are Powerful and Efficient
A shortcut is an icon you create that contains a path (a direct route) to a
specific object (the target).  The target object might be a document, program,
folder, disk drive, or printer.  A shortcut is easily identified by the jump arrow
that appears on the lower-left corner of its icon.

Shortcuts are powerful because they offer quick access to frequently used
objects while Windows does all the work of keeping track of what you are
doing.  Shortcuts are efficient because when you use a shortcut to jump from
one place to another you do not have to:

� remember folder and subfolder names,
� work through a lot of menus,
� open a lot of folders, or
� type a long path name.

Creating a shortcut can be as easy as using Search Assistant to locate the
object you want and then dragging the object onto the desktop.  While you
can place shortcuts just about anywhere, often the most practical place to put
them is on the desktop, where they are handy.

While shortcuts let you jump to different locations without appearing to follow
the actual path, behind the scenes Windows keeps track of your
movements—as you can see in the Shortcut to Calc Properties dialog box
below.  To view a shortcut object’s path, open the shortcut's Properties dialog
box, click the Shortcut tab, and look at the Target text box.

Shortcut icon

Jump arrow (indicates that this is a shortcut icon)

Right-click
the shortcut
icon, then...

...click Properties.
Shortcut to Calc Properties 

Dialog Box

The Target text box
shows the path to
CALC.EXE, the
target object.
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document
A file that consists of data created in a program,
such as a letter typed in WordPad or a picture
drawn in Paint.  Also called data file.

document-centric
A system that focuses on documents and their
contents rather than on the programs used to
create those documents.

�
Documents Are Central
As we have seen in Topics 18 and 19, the desktop is the heart of Windows
2000, and shortcuts can be powerful and efficient tools in this environment.
Throughout this book, hovever, you will notice that the center of activity is
usually the document.  Much of what you do on your computer system
revolves around producing documents of one kind or another.  Realizing this,
Microsoft designed Windows 2000 to be document-centric, that is, centered
around documents rather than the programs used to create them.

Different Ways to Open a Document
Using the Documents menu:

� click the Start button,
� point to the Documents menu, and
� click the document (if it is one of the last 15 documents used).

Using most program File menus:
� open a program,
� click the File menu, and
� click the document (if it is one of the last four documents used).

Using the Open dialog box:
� open a program,
� click File, then click Open,
� find the folder the document is in, and finally,

� click the filename, then click .

Clicking a document file icon:
� double-click a document file icon (when in classic-style mode or in dialog

boxes).
OR
click a document file icon on the desktop or in folder windows (when in
Web-style mode).

File-Management Tasks

TOPIC 20 � �	
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Create it
Print it

Mail it

View it

Document
Move it

Copy it

Combine it with
other documents

Cut & paste part of it

Drag & drop it

Put it on the desktop

Recycle it

Create a shortcut to it

Resave it

Save it

Rename it

Name it
Edit it
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The Documents Menu
When you open the Documents menu, you can see up to 15 of your most
recently used (saved and/or opened) documents.  The My Documents folder
is displayed where it is easy to access, at the top of the Documents menu.
The My Documents folder was designed as a handy place to put your
personal documents.

Documents on the File Menu
The last four documents you opened and/or saved are listed in the recently
used files section near the bottom of the File menu in most programs.  Simply
click a document listed on the File menu to open it.

Double-click a Document File Icon
The illustration below shows documents in the 3½ Floppy (A:) folder window.

Recently
used files

To open winfun, 
double-click its icon.

My Documents folder

The Documents menu holds the
My Documents folder and the
last 15 documents used.
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Active Desktop
The Windows 2000 desktop that consists of two
layers: one layer on which you can display
standard desktop objects, and a second layer
on which you can display HTML objects.

HTML (Hypertext Markup Language)
The programming language used to create Web
pages so that they can be viewed, read, and
accessed by any computer running on any type
of operating system.

Internet Explorer 5 (IE5)
The Windows 2000 Web-browsing program with
a built-in interface to the Active Desktop and
with many easy-to-use features that open the
door to the world of information on the Internet.

standard desktop
A place to put objects (such as icons for
shortcuts, folders, and files) for quick and easy
access.  The standard desktop cannot,
however, display HTML objects.

Web browser
A program that lets you access the Web and
view Web pages.  Also called browser.

Web-page object
An object that appears in Web pages, such as
text, a hyperlink, a graphic image, or an
animated graphic image.

work offline 
To view Web pages (and Web-page objects)
that are stored on the computer without being
connected to the Internet.  

�
The Standard Desktop
The standard desktop is a place to put objects for fast, easy access.  Such
objects include:

The Active Desktop
The Active Desktop adds another layer to the standard desktop.  The Active
Desktop is an HTML background layer that can display HTML objects—either
from the Web or on your own hard drive.  HTML (Hypertext Markup Language)
is a common computer-programming language used to format Web pages.  Web
browsers, such as Internet Explorer, understand HTML.  The Active Desktop
can also understand HTML.  It is the HTML background layer that defines the
Active Desktop.

When your desktop is active, you can put Web-page objects on it, such as:

The Active Desktop with Web-Page Objects

In this lesson, you will be working with some Web elements and using Internet
Explorer in work-offline mode (not connected to the Web).  

� headlines for breaking news
stories

� tickers for stock quotes
� weather maps

� an HTML document created in
Notepad

� graphics

� the Start button
� the taskbar
� the My Computer, 

My Documents, Internet
Explorer, Network
Neighborhood, and 
Recycle Bin icons

� shortcuts to your most
frequently used programs

� folders that hold groups of
related objects

� documents that you want to
keep handy
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Weather map

HTML document
created in Notepad

Animated graphic
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folder window
A window that displays the contents of a folder
(or certain other objects, such as disk drives).
Folder windows offer many of the same folder-
managing features as Windows Explorer.  Click
a folder (if Web-style browsing is enabled) to
open its window and see what is in it.

hierarchy
A system of things (or people) ranked one
above the other.  With regard to computers, the
term hierarchy describes the multilevel structure
of folders and subfolders on a disk.  In the case
of Windows 2000, it further describes the
multilevel structure of objects on the entire
computer system.  This structure is also
referred to as a tree.

Windows Explorer
The Windows 2000 program that you can use to
look at and manage objects in your computer
system, including remote computers if your
system is networked.  The left pane displays All
Folders (a hierarchy of folders); the right pane
displays the contents of the folder that is
selected in the left pane.
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�
A Look at Your Computer's Resources
Windows Explorer lets you see where your computer's resources are
located.  The Explorer window is divided into two panes.  The left pane
displays the Windows hierarchy; it is labeled Folders (it is really the Folders
Explorer Bar).  The right pane displays the objects within the folder (or object)
selected in the left pane.  The title bar displays the name of the folder (or
object) selected in the left pane, as do the Address bar and the Web View
area.   

.

The Windows 2000 version of Windows Explorer is designed to be just the
same as a folder window whose Folders Explorer Bar is selected.  Therefore,
if you are in a folder window and you want to see the computer's folder
structure, simply click the Folders button.  Instantly, the folder will be
transformed into Windows Explorer with the current folder selected in the left
pane and with the folder hierarchy ready to be fully revealed as you expand
folders to display their subfolders.

The following Windows Explorer characteristics may be useful to keep in
mind.  When exited and then restarted, Windows Explorer remembers:

� the previous icon view for each folder
� the previous icon arrangement for each folder
� the previous restored size and position
� the maximized or restored state of Windows Explorer for each folder if

Windows Explorer is opened by right-clicking that folder; otherwise,
folders selected after Windows Explorer is opened will retain the current
window size during the current session

In the Windows 2000 version of Windows Explorer, each folder that is selected
in the left pane will retain the icon view (i.e., Large Icons, Small Icons, List,
and Details) you select for it in the right pane.  This is unlike earlier versions of
Windows Explorer in which the icon view you select affects all the folders.

In Windows 2000, the option that enables Web content in folders affects all
folder windows (and Windows Explorer), unlike earlier versions of Windows in
which the option can be turned on or off in individual folder windows (and
Windows Explorer as well).

����	���!��"	��� � TOPIC 22

(C:)

Left pane (All Folders) Web View area Right pane (contents of the folder selected in the left pane)
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collapse
To hide the folders contained in an object.
Objects that can be collapsed have a minus
sign (−) beside them.  It may help to think of
collapse as "close."

collapsed
The state of a folder that has a plus sign (+)
beside it.  A collapsed folder has folders within
it that are not visible.  It may help to think of
collapsed as "closed."

expand
To display the unseen folders contained in an
object.  Objects that can be expanded have a
plus sign (+) beside them.  It may help to think
of expand as "open."

expanded
The state of a folder that has a minus sign (−)
beside it.  The folders within an expanded folder
are displayed immediately below it.  It may help
to think of expanded as "opened."

Folders pane
The left pane of Windows Explorer that displays
the hierarchical structure on your computer
system, including remote computers if your
system is networked.

subfolder
A folder contained within another folder.

�
The Left Pane of Windows Explorer Shows the Computer's
Structure
Because you often use shortcuts to
quickly access folders and files, you
may not think about the structure of
your computer with its many levels of
folders and files.

Windows Explorer helps you see how
your computer system is structured.
The illustration on the right shows
how Windows Explorer displays the
computer’s structure in the Folders
pane (the left pane).

Notice that the desktop is the top-level
folder on your computer system (i.e.,
level one).  The desktop links you to
your local computer via My Computer, 
to network computers—if you’re
connected to remote computers—via
My Network Places, and to the
Internet via your Web browser (e.g.,
Internet Explorer).

Because the desktop is also a folder,
you can store objects, such as
shortcuts, folders, and files, there.
Folders within the Desktop folder are
second-level folders.  Folders within
second-level folders are third-level
folders, and so forth, as shown in the
illustration.

A plus sign (+) beside a folder means
that the folder is collapsed (closed),
so you can’t see the subfolders it
contains.  Click a folder's plus sign to
expand (open) the folder and show
its subfolders.

A minus sign (−) beside a folder
means that the folder has been
expanded (opened) to show its
subfolders.  Click a folder's minus
sign to collapse (close) it and hide 
its subfolders.

The illustration on the right shows 
some expanded folders and a lot of
collapsed folders. This is an effective
way to depict a computer’s structure.
Another way to represent a
computer’s structure is somewhat 
like an organizational chart for a
company—also called a tree (see
Topic 16—Windows 2000 Structure).
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1 2 3 4 5 6 7 8 9

Desktop folder

Levels

Collapsed
folder

Expanded
folder

(This is the menu
you open with the
Start button.
Notice that its
subfolders are also
submenus in the
Start menu on
your desktop.)

Start Menu
folder
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associated file
A file that has been identified as belonging to a
certain program, such as .txt with Notepad,
.bmp with Paint, or .doc with Microsoft Word.
When you open an associated file, the program
related to that file opens automatically.

filename extension
The period and, usually but not always, three
characters at the end of a filename (for
example, .doc, .txt, .gif).  Also called file
extension.

�
Two File Options Produce Notable Changes
There are two advanced file options that change the way files and folders are
viewed.  One, Hide file extension for known file types, is discussed below; the
other, Hidden files and folders, is discussed on the next page.  Changing
these options has the potential to cause serious problems.  The View tab of
the Folders Options dialog box is where you change them.

Hide File Extensions for Known File Types
When selected, the Hide file extensions for known file types check box hides
most filename extensions.  (This is the default setting.)

As discussed in Topic 10—Program File Types, filename extensions associate
a document file with a specific program.  While the computer system must use
filename extensions to identify document types, you may prefer to use
program icons to identify document types.  Some users like to display
filename extensions; others feel filename extensions just add clutter.

This is how the filename appears This is how the filename appears
when filename extensions when filename extensions
are hidden: are not hidden:

Deselecting the Hide file extensions for known file types check box can affect
the results of the exercises in this book in which you rename files.  If you
rename a file when filename extensions are hidden, Windows 2000
automatically adds the correct filename extension.  If, however, filename
extensions are showing, you must provide the filename extension for the
renamed file.  If you do not provide the filename extension (or if you change
it), a dialog box warns you that the file may become unusable.

&�"��+���	�� � TOPIC 24

No filename extension filename extension

Hide file extensions for
known file types check
box (selected)

Hidden files and folders
(There are two option
buttons in this section.)



168 Appendix

Terms and Notes

attribute
A characteristic (such as read-only, archive,
hidden, or system) that changes how a file or
folder can be used or displayed.

hidden files
Files and/or folders to which the Hidden
attribute has been applied.

�
Hidden Files and Folders
The Hidden files and folders feature is located in the View tab of the Folder
Options dialog box.  One of the following Hidden files option buttons must be
selected:

� Do not show hidden files and folders
Keeps you from accidentally changing or deleting hidden files and folders.
Reduces clutter in your folder windows and in Windows Explorer. This is the
default setting.

� Show hidden files and folders
Specifies that all files and folders, even hidden and system files, appear in
your folder windows and in Windows Explorer.

Certain folders that are shipped with Windows 2000 come with the Hidden
attribute selected.  These folders, which Windows 2000 uses, are best left
hidden.  When displayed, hidden and system files are exposed to the possibility
of being deleted accidentally.

Hidden files and folders will not appear in folder windows or in Windows
Explorer unless you select the Show hidden files and folders option button.  To
show all files:

� Click the Start button, point to Settings, click Control Panel, then 
double-click Folder Options.

� Click the View tab, select Show hidden files and folders, then click the
OK button.

You can easily identify files and folders that have the Hidden attribute selected
because their icons appear dimmed.

You may want to use the Hidden attribute for some of your personal folders
and/or files.  To change the Hidden attribute:

� Right-click a file or folder, click Properties, then click the General tab.
� Click the Hidden check box to select or deselect the option as desired.
� Click the OK button.

Below is the INF Properties dialog box with the Hidden check box selected.

Hidden check box (selected)
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Search Assistant
The Windows 2000 search feature (also known
as the Search Explorer bar); it has separate
sections that help you:
� locate files or folders
� find people (in your address book)
� locate other networked computers 
� search the Internet

When you click the Search button in Windows
Explorer and folder windows, Search Assistant
opens the Files or Folders section; however,
when you click the Search button in Internet
Explorer, Search Assistant opens the Internet
section. You can open a different section at any
time by clicking its hyperlink at the bottom of
Search Assistant.

search criteria
Guidelines you define that tell Search Assistant
what file and folder characteristics to look for
when searching.  For example, you can search
for all the files that contain the .doc filename
extension or for all the files that were created in
the last month.

search results
The files and/or folders that meet the search
criteria you specified.  The search results
appear in the work area in the right pane of
Search Assistant after you click the Search Now
command button.

�Search Assistant
Search Assistant is a Windows feature that helps you locate:

� files and folders
� printers
� other computers on your network
� people in your address book

Although Search Assistant has the many search capabilities listed above, this
lesson covers searching for files and folders only. 

You can start Search Assistant in several ways:
� Click Start, click Search, then click For Files and Folders.
� Right-click a folder, then click Search.
� Click the Search button in a folder window or Windows Explorer.
� Press the F3 key.

Search Assistant is called the Find program in previous versions of Windows.
The Windows 2000 Search feature has been redesigned to resemble folder
windows; it has the same Menu bar, Standard toolbar, and Address bar.
When you press the Search button in a folder window, it opens the Search
Explorer bar (a.k.a. Search Assistant) on the left side of the window.

When you search for files and folders, you need to tell Search Assistant
something about the file or folder you are looking for.  You give it clues such
as where the file may be located or a name or partial name of the file.  These
clues are called search criteria.  You describe the search criteria using the
Search Options section and some parts of the section above the Search
Options.  Here is a list of search criteria that you can use to find files or
folders:

� filename
� file contents
� file location

The Advanced Options choices further refine search criteria, making a search
for the files you want even more sensitive.  
On the next page, three illustrations show the:

− Search Explorer bar with the Search Options collapsed.
− Search Explorer bar with the Search Options expanded.
− Search Explorer bar with the Search Options fully expanded (the

items within the Search Options are expanded).
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� Web pages, addresses,
businesses, previous 
searches, and maps on
the Internet

Search button

Search Explorer bar
(or Search Assistant)

New button (clears
the current search)

Search Options
section

Search results appear in the right
pane after you tell the Search
Assistant what to search for and
then click the Search Now button.

� file date
� file type
� file size

� advanced options

Continued on the next page
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Close button

Search Explorer
bar with Search

Options collapsed

Search Explorer
bar with Search

Options expanded

Search Explorer bar
with Search Options

fully expanded

New button

Search Now button

Stop Search button

Search Options,
collapsed Search Options,

expanded

Search Options, fully expanded
(The Date, Type, Size, and
Advanced Options may be
expanded one at a time as you
need to use them.)

File name

Search criteria:

File content

File location

File date

File type

File size

Advanced options

Continued from the previous page


